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Before You Begin

Before You Begin

This section provides you with safety information, technical support
information, and sources for additional product information.

Safety Information

Your safety is extremely important. This section explains how to
identify notes that are in this document.

special instructions for handling a particular condition or set of

§ Note: Notes either provide extra information about a topic or contain
circumstances.

Global Services and Support

Warranty Information

To understand the warranty for your Intermec product, visit the
Intermec web site at www.intermec.com and click Support >
Returns and Repairs > Warranty.

Web Support

Visit the Intermec web site at www.intermec.com to download our
current manuals (in PDF). To order printed versions of the Intermec
manuals, contact your local Intermec representative or distributor.

Visit the Intermec technical knowledge base (Knowledge Central) at
www.intermec.com and click Support > Knowledge Central to
review technical information or to request technical support for your
Intermec product.

Telephone Support
In the U.S.A. and Canada, call 1-800-755-5505.

Outside the U.S.A. and Canada, contact your local Intermec
representative. To search for your local representative, from the
Intermec web site, click About Us > Contact Us.
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Before You Begin

Service Location Support

For the most current listing of service locations, go to
www.intermec.com and click Support >Returns and Repairs >
Repair Locations.

For technical support in South Korea, use the after service locations
listed below:

AWOO Systems

102-1304 SK Ventium

522 Dangjung-dong

Gunpo-si, Gyeonggi-do Korea, South 435-776
Contact: Mr. Sinbum Kang

Telephone: +82-31-436-1191

E-mail: mjyun@awoo.co.kr

IN Information System PTD LTD

6th Floor

Daegu Venture Center Bldg 95

Shinchun 3 Dong

Donggu, Daegu City, Korea

E-mail: jmyou@idif.co.kr or korlim@gw.idif.co.kr

Who Should Read This Manual

This manual is for the person who is responsible for installing,
configuring, and maintaining the IF30.

This manual provides you with information about the features of the
IF30, and how to install, configure, operate, maintain, and
troubleshoot it.

Before you work with the IF30, you should be familiar with your
network and general networking terms, such as IP address. You
should also be familiar with your RFID system.

Related Documents

Document Title Part Number

Basic Reader Interface Programmer’s Reference  P/N 937-000-xxx
Manual
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The Intermec web site at www.intermec.com contains our
documents (as PDF files) that you can download for free.

To download documents
1 Visit the Intermec web site at www.intermec.com.
2 Click Support > Manuals.

3 Use the Product Category field, the Product Family field, and
the Product field to help you locate the product whose
documentation you want to download.

Patent Information
Product is covered by one or more of the following patents:

4,999,636; 5,030,807; 5,055,659; 5,070,536; 5,280,159; 5,295,154;
5,349,678; 5,394,436; 5,425,051; 5,428,636; 5,483,676; 5,504,48S5;
5,504,746; 5,521,601; 5,546,397; 5,550,547; 5,574,979; 5,592,512;
5,673,037; 5,680,633; 5,682,299; 5,696,903; 5,740,366 5,763,867;
5,777,561; 5,790,536; 5,825,045; 5,828,318; 5,828,693; 5,844,893;
5,850,181; 5,850,187; 5,862,171; 5,940,771; 5,942,987; 5,960,344;
5,995,019; 6,078,251; 6,121,878; 6,122,329; 6,172,596; 6,195,053;
6,249,227; 6,280,544; 6,286,762; 6,286,763; 6,288,629; 6,360,208;
6,384,712; 6,404,325; 6,429,775; 6,486,769; 6,501,807; 6,525,648;
6,639,509; 6,645,327; 6,677,852; 6,768,414; 6,784,789; 6,816,063.

There may be other U.S. and foreign patents pending..
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Getting Started

This chapter introduces the IF30 Fixed Reader. It explains the
ports and LEDs, and explains how the reader fits into your
network. It contains these topics:

Overview of the IF30

What’s New

Unpacking the IF30

Learning About the IF30

How the IF30 Fits in Your Network
Configuring the IF30 (Setting the IP Address)
Saving Configuration Changes

Installing the IF30

Setting the Date and Time

Using the IF30 Securely



Chapter 1 - Getting Started

Overview of the IF30

The IF30 Fixed Reader is an RFID reader that provides connectivity
between tag data and an enterprise system.

The IF30 Fixed Reader

y= The IF30 Fixed Reader uses an EPCglobal Gen 2-certified IMS Module
v (86x MHz RFID frequency band).

95011071 26000000094

= The IF30 Fixed Reader uses an EPCglobal Gen 2-certified IMS Module
/| (915 MHz RFID frequency band).

9501101 26000000100

What’s New

Manual was revised to support the new ETSI standard for RF
products.
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Chapter 1 - Getting Started

Unpacking the IF30

When you unpack the IF30, save the box and shipping material in case
you need to ship or store the IF30. The reader comes with a
documentation packet that includes a quick start guide and a safety
and compliance statement.

The IF30 Out of the Box

information on these accessories, contact your Intermec sales
representative.

What You Need

To install and connect the IF30, you need these items:

§ Note: The IF30 does not ship with RFID antennas. For more

* Anappropriate AC power cord
» Appropriate RFID antennas and cables

e An Ethernet cable

IF30 Fixed Reader User’s Manual 3



Chapter 1 - Getting Started

Learning About the IF30

This section explains the ports and LEDs on the IF30.

Understanding the Front Panel Ports

The IF30 front panel has four ports. To access three of the ports, you

need to remove the cable access door.

To remove the access door

e On the underside of the IF30, unscrew the two thumbscrews on

the cable access door and remove the door.

Cable access
door

Control port

% L@fﬁ/
<

AC power port Ethernet port Serial port

IF30 Front Panel Ports: This illustration shows how to remove the cable access

door and where the ports are located.
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IF30 Front Panel Port Descriptions

Port Description

AC Power Used with an appropriate power cable, this port connects the
reader to an AC power source.

Ethernet 10BaseT/100BaseTx port. Used with an appropriate cable,
this port connects the reader to your Ethernet network. The
reader auto-negotiates with the device it is communicating
with so that the data rate is set at the highest rate at which
both devices can communicate.

Serial Used with an RS-232 null modem cable (P/N 059167), this
port connects the reader to a terminal or PC to perform
configuration.

Control General purpose input/output (GPIO) port. This port

connects the reader to industrial controls such as relays or
indicators. The port includes optically-isolated inputs,
optically-isolated low voltage DC outputs, and access to 12
VDC.

For more information on the IF30 GPIO interfaces, see
“About the GPIO Interfaces” on page 72.

For more information, see “Port Pin Assignments” on page 84.
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Understanding the LEDs

The IF30 has three LEDs that show you the operating status of the
reader.

IF30 LEDs
LED Descriptions
LEDIcon LED Name Description
I Power Remains on after the IF30 boots.
._I: Wired LAN Flashes when a frame is
transmitted or received on the
Ethernet port.
"i Intermec Blue LED remains on when an
\r> Ready-to-Work™ application is communicating

indicator with the data collection engine
(DCE) on the IF30. Blinks when
no application is communicating
with the DCE. For more
information, see the next section.
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Learning About the Intermec Ready-to-Work Indicator

The blue Ready-to-Work Indicator shows when an application is
communicating with the data collection engine (DCE) on the IF30.

The next table explains the different states of the Ready-to-Work
indicator.

Ready-to-Work Indicator Status Descriptions

Status Description

Off The IF30 is not yet ready for operation.

Blinking The BRI server is running but no applications have
connected to the BRI TCP port.

Steady An application is communicating with the BRI
server.

Or, your custom application is communicating with
the DCE.

For more information on the DCE, see “Configuring the Data
Collection Engine” on page 49.
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Chapter 1 - Getting Started

Understanding the Rear Panel Ports

A\

Caution

£

The ports on the rear panel are used for connecting the IF30 to RFID

antennas.

RFID antenna
ports (4 places) Terminators

IF30 Rear Panel Ports: This illustration shows the ports on the rear panel. The
IF30 ships with antenna terminators mounted on RFID antenna ports 2, 3, and
4.

The IF30 RFID antenna ports use these connectors:
* 865-869 MHz: SMA
* 915 MHz: Reverse SMA

Make sure you have appropriate antennas and cables for your IF30.
For help, contact your Intermec sales representative.

Government regulatory agencies require that this RFID reader
only use approved antennas. Therefore, this reader uses a custom
antenna connector. Do not use antennas not approved for use
with this reader.

Note: The IF30 ships with antenna terminators installed on RFID
antenna ports 2, 3, and 4. Do not remove the terminator from any port
unless you are installing an antenna or antenna cable on that port.
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Chapter 1 - Getting Started

How the IF30 Fits in Your Network

In general, the reader forwards RFID tag data to the wired Ethernet
network. The next illustrations show how the IF30 fits in your

network.
Z | RFID
Y antenna
IF30 with
= Ethernet
connection

IF30 in a Wired Ethernet Network:This illustration shows the IF30 in a wired
Ethernet network. The IF30 sends and receives RFID tag data to the RFID server
through the wired network.

Container
with RFID tag

Configuring the IF30 (Setting the IP Address)

%

By default, the IF30 is configured to be a DHCP client and accepts
offers from any DHCP server. Therefore, the IF30 will work directly
out of the box.

However, if you are not using a DHCP server to assign an IP address
you need to use a communications program, such as HyperTerminal,
for the initial configuration. For help, see “Using a
Communications Program” on page 10.

After the IF30 has been assigned an IP address, you can configure,
manage, and troubleshoot the IF30 from a remote location using a
web browser interface. For help, see “Using the Web Browser
Interface” on page 14.

Note:This manual assumes that you are using a communications
program for your initial configuration, and then using a web browser
interface to perform all other configurations. You can also continue to
use a communications program to configure the IF30.

IF30 Fixed Reader User’s Manual 9
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Using a Communications Program

10

You can use a communications program (such as HyperTerminal) to
set the initial IP address for the IF30. After you configure the IP
address, you can continue to use the communications program to set
other parameters or you can use a web browser to complete the
configuration.

To use a communications program, you must have:

* aterminal or PC with an open serial port and the communications
program.

* an RS-232 null-modem cable (P/N 059167). One end of this cable
must be a 9-pin socket connector to connect to the serial port on
the IF30. To order this cable, contact your local Intermec
representative.

Note: If you have Microsoft ActiveSync running on your desktop PC,
you may need to disable ActiveSync to make the serial port available.

To use a communications program

1 Use the RS-232 null-modem cable to connect the serial port on the
IF30 to a serial port on your PC.

2 Start the communications program and configure the serial port
communications parameters on your PC, and then click OK. You
should configure the serial port communications parameters to:

Parameter Setting

Bits per second 9600

Data bits 8
Parity None
Stop bit 1
Flow control None

3 Connect the IF30 to AC power. The IF30 boots as soon as you
apply power.
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Chapter 1 - Getting Started

4 Press Enter when the message “Starting system” appears on your
screen. The Username field appears.

IF30 RFID Reader Configuration
Copyright (c) 1995-2006 Intermec (R) Technologies
All rights reserved.

Ethernet IP: 16.10.101.53
Serial: 07200500013

Username:

5 In the Username field type the default user name intermec, and
then press Enter.

6 In the Password field type the default password intermec, and
then press Enter. The IF30 RFID Reader Configuration menu
appears.

[F30 RFI Configuration

To configure the IF30 for your Ethernet connection, continue
with the next procedure.

Configuring the IF30 for an Ethernet Connection

Follow this procedure to configure the IF30 for your Ethernet
connection that does not use a DHCP server. If your wired network
uses a DHCP server, you can skip this procedure and continue with
“Connecting the IF30 to Your Network” on page 19.

To configure the IF30 for a wired Ethernet connection

1 Connect to the IF30 using a communications program. For help,
see “Using a Communications Program” on page 10.

IF30 Fixed Reader User’s Manual 11



Chapter 1 - Getting Started

2 With Ethernet selected in the IF30 RFID Reader Configuration
menu, press the right arrow. The Ethernet menu appears.

DHi <Always Use DHCP>

3 Configure these settings:

Parameter Setting

DHCP Mode Set to Disable DHCP.

IP Address A unique IP address.

IP Subnet Mask The subnet mask that matches the other devices
in your network.

IP Router If the IF30 will communicate with devices on

(Gateway) another subnet, enter the address of the router

that will forward frames.

Or, press the down arrow key to select IPv6 Configuration, and
then press the right arrow key to configure these IPv6 settings:

Parameter Setting

Enable Enables automatic assignment of a unique
Autoconfiguration addpress to this IF30.

IPv6 Address A unique 128-bit IPv6 address.

IPv6 Subnet Mask The IPv6 subnet mask. Range is 1 to 128 bits.
IPv6 Router A unique 128-bit address for an IPv6 router.
(Gateway)

12 IF30 Fixed Reader User’s Manual



Chapter 1 - Getting Started

4 (Optional) To configure DNS settings, choose Network Services
and press Enter. The Network Settings screen appears.

5 Configure the DNS settings as needed:Configure these settings:

Parameter Setting
Hostname Hostname for this IF30. The default is IF30 pre-
pended to the serial number of the unit.

This can be a simple hostname or a fully
qualified domain name (FQDN). If this device
obtains its IP address via DHCP, this parameter
is also sent to the DHCP server. If the DHCP
server supports it, this field will be used for
dynamic DNS (DDNS) updates.

DNS Address 1 IP address of a domain name server that the IF30
uses to resolve DNS names.

DNS Address 2 IP address of a domain name server that the IF30
uses to resolve DNS names if the DNS server at
DNS Address 1 is not responding.

DNS Suffix 1 Domain name suffix that will be appended to

DNS names that cannot be resolved.

DNS Suffix 2 Domain name suffix that will be appended to
DNS names that cannot be resolved either by
themselves or using DNS suffix 1.

6 Press the left arrow key to return to the main reader configuration
menu.

7 Press the down arrow key to select Save Configuration and then
press Enter. The new settings are saved.

8 Press the down arrow key to select Reboot and then press Enter.
The IF30 reboots. When the boot process is finished, you see
“Starting system...” at the bottom of the HyperTerminal screen.

IF30 Fixed Reader User’s Manual 13
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9 Disconnect the null-modem cable and AC power cable from the
IF30.

The IF30 is now ready to be connected to your network. See
“Connecting the IF30 to Your Network” on page 19.

Using the Web Browser Interface

After you have set the initial IP address, you can configure and
manage the IF30 remotely using the web browser interface. The IF30
web browser interface has been tested using Internet Explorer 6.0.
Using other browsers may provide unpredictable results.

To use the web browser interface, the IF30 must be connected to your
wired Ethernet.

If your session terminates abruptly or a new login screen appears,
someone else may have accessed the IF30. When using the web
browser interface, remember that your session terminates if you do
not use it for 15 minutes.

Note: If you access the Internet using a proxy server, add the IF30 IP
& address to your Exceptions list. The Exceptions list contains the

addresses that you do not want to use with a proxy server.

To use the IF30 web browser interface

1 Determine the IP address of the IF30. If a DHCP server assigned
the IP address, you need to get the IP address from that server.

2 Start Internet Explorer.

14 IF30 Fixed Reader User’s Manual
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3 In the Address field, enter the IP address, and press Enter. The
IF30 login screen appears.

Intermec®
[ RFID
0 R D Reade 0

Security Login credentiaks

Note: This login session is

T Password: [ ]
A secure session is available

Some features such as
importing certificates are only Loaln,
available through the secure
interface,

To only allow secure login and
avoid ever sesing this message,
change the "Browser Access”™
option under the “Security™
menu to "Secure-Only”

Once you enter the comect user name and/or password, you wil be logged in to the configuration menus. After
fifteen minutes of inactivity you will be logged out.

Copyright © 1995-2006 Intermec ® Technologies Corporation, All rights reserved,

Or, for a secure session, click A secure session is available. The
secure login screen appears.

4 If necessary, enter a user name and password. The default user
name is intermec and the default password is intermec. You can
define the user name and password. For help, see “Setting Up
Logins” on page 33.

5 Click Login. The Ethernet screen appears.

: Logout ‘ Save/Discard Changes ‘ Upgrade Software ‘ Help |

Mavigation Menu Secure IF30 RFID Reader Configuration

= @ Ethernet
e Submit Changes

1Pv6 Configuration
B RFID Module

DHCF Modle Use DHCP if IP Address is Zero |+
B B Metwiork Services :
B Htwark Management P Address 136.179.85.105
B security P Subnet Mask 255 255 255.0

(- B maintenance 1P Router (Gateway) 136.179.65.1

DS Metwork Services

Link Speed Auto Select

Copyright @ 1995-2006 Intermec ® Technologies Corporation, All rights reserved,

Your web browser session is established.

Note: Although you can use several methods to manage the IF30
§ remotely, this manual assumes you are using the web browser.

IF30 Fixed Reader User’s Manual 15
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Saving Configuration Changes

When you are done configuring the IF30, you may want to activate
your changes immediately or you may want to save the changes now
and activate them later. If you choose to activate the changes later,
they will become active the next time the IF30 is booted.

Note: If you made changes to RFID module settings, you need to
& reboot the IF30 to activate those changes.

IF30 Configuration Files

Configuration File Description

Default This configuration file is the factory default
configuration. For help, see “Restoring the IF30 to
the Default Configuration” on page 66.

Current When you click Submit Changes, the IF30
updates the current configuration file. The IF30
does not change the active configuration file. You
can see a list of pending changes when you click
Save/Discard Changes. Having separate files for
the current and active configurations lets you make
changes while the IF30 is running without
interrupting communication.

Active When you click Save/Discard Changes > Save
Changes and Reboot, the IF30 copies the current
configuration file to the active configuration file.
The active configuration file is the file that the IF30
uses.
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To save or discard configuration changes

1 On the menu bar, click Save/Discard Changes.

‘ Logout | Save/Discard Changes | Upgrade Software | File Import/Export |

The Save/Discard Changes screen appears.

Logout ‘ Save/Discard Changes ‘ Upgrade Software |

Save/Discard Changes
Havigation Menu Secure [F30 RFID Reader Configuration
B B Ethernet

TP Configuration
B RFID Modul
B network Services
B nletwork Management
B Security
B Maintenance

Save Changes and Reboot | ‘ Discard Changes and Reboot

Save Changes without Reboot

Discard Pending Changes | ‘ Restore Factory Defaults

Possible Configuration Errors

The login password has not been changed from its default value,

Pending Changes

MO CHAMGES

To discard changes, click Discard Pending Changes.
To save changes, continue with the next step.

Verify that all your configuration changes appear in the Pending
Changes list.

Click Save Changes and Reboot to reboot the IF30 and
immediately use your new active configuration.

Or, click Save Changes without Reboot. The IF30 saves the
changes to its current configuration and continues to run its
active configuration. You will need to reboot the IF30 when you
want the current configuration to become the active
configuration.
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Installing the IF30

This section explains how to choose a mounting location for the IF30
and connect the IF30 to your wired Ethernet network.

Choosing a Mounting Location

18

You can place the IF30 horizontally or vertically on a stable surface.
You can also mount the IF30 to a wall or a beam using one of these
mounting bracket kits:

* Mounting bracket kit (P/N 068918)
* Rotating mounting bracket kit (P/N 068751)

For more information, contact your local Intermec representative.

Wall

Mounting the IF30: This illustration shows the ways you can install the IF30 on
a horizontal or vertical surface.

The next table includes environmental requirements for the IF30.
Choose a location that meets these requirements.

IF30 Environmental Requirements

Type Minimum Maximum
Operating temperature -25°C (-13°F) 55°C (131°F)
Storage temperature -30°C (-22°F) 75°C (167°F)
Humidity (non-condensing) 10% 90%
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Connecting the IF30 to Your Network

After you configure the IF30 for your network and choose a mounting
location, you can place the IF30 in its mounting location and connect
it to your network.

%

A

Warning

%

For help with configuring the IF30, see “Configuring the IF30
(Setting the IP Address)” on page 9.

Note: If there is no DHCP server available at boot time, the IF30 will
not be able to communicate on the network while searching for DHCP
lease offers.

To install the IF30

1

Remove the cable access door. For help, see “Understanding the
Front Panel Ports” on page 4.

Attach one to four RFID antennas to the RFID antenna ports,
starting with port 1. Do not remove the terminators from unused
antenna ports. For help, see “Understanding the Rear Panel
Ports” on page 8.

Each port must have either an antenna or a terminator
connected. Do not apply power to the reader unless an
antenna or terminator is installed on each antenna port.

Connect an Ethernet cable to the IF30 Ethernet port.
Connect the AC power cord to the power port on the IF30.

Note: The IF30 does not support power over Ethernet (POE).

Install the cable access door and route the cables through the
openings in the door seam. Make sure the cables are not caught in
the seam.

Place the IF30 in its mounting location. For more information, see
“Choosing a Mounting Location” on page 18

7 Connect the Ethernet cable to your network.

Connect the AC power cord to an AC outlet. As soon as you apply
power, the IF30 boots and the green Power LED turns on.
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The IF30 is now ready to communicate in your network.

Setting the Date and Time

After you have installed the IF30, you can set the date and time via the
web browser interface.

To set the date and time

1 Connect to the IF30 via the web browser interface. For help, see
“Using the Web Browser Interface” on page 14.

2 On the web browser screen, click the date and time in the upper
right-hand corner.

Intermec:

ntarmec
Tuesday, Nove

Logout | Save,/Discard Changes | Upgrade Software | Help |

The Set Clock screen appears.

Logout | Save/Discard Changes ‘ Upgrade Software ‘

0
Navigation Menu Securs IF30 RFID Reader Configuration
B Ethernet

B @ RFID Module

B B Network Services

Date (MMDDYYYY)  11/21/2008

B B Metwork Management | Time (HHMMISS) 21:46:04
-] Security
B Mmainkenance

3 In the Date field, enter the current date using the format
MM/DD/YYYY, where:

MM is the month.
DD is the date.
YYYY is the year.
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4 In the Time field, enter the current time using the format
HH:MM:SS, where:
HHis the correct hour in UTC (24-hour) format.
MM is the correct minute.
SS is the correct second.

5 Click Set. The IF30 date and time are set.

Using the IF30 Securely

You can protect the integrity and security of your data on the IF30 by
using a secure web browser session (HTTPS) to access the IF30. For
help, see “Using the Web Browser Interface” on page 14.
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Configuring Network Settings

This chapter describes how to configure network settings for
the IF30 and includes these topics:

* Configuration Settings For Your Network
* Configuring Ethernet Settings

* Configuring Network Services

* Configuring Security

e About Certificates

23
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Configuration Settings For Your Network

This chapter assumes that you are using the IF30 web browser
interface to configure network settings on the IF30. For help, “Using
the Web Browser Interface” on page 14.

You can also configure network settings by:

using a communications program to access the IF30. For help, see
“Using a Communications Program” on page 10.

using Intermec Settings from within the Intermec SmartSystems
Console. For help, see “Using SmartSystems Foundation” on
page 56.

Configuring Ethernet Settings

24

This section explains how to configure the wired Ethernet settings
using the web browser interface:

DHCP mode

(If DHCP is enabled) DHCP server name, user class, and vendor
class

IP address
IP subnet mask
IP router (gateway)

Link speed

Note: If you are using a DHCP server, you may not need to configure
Ethernet settings. For more information, contact your network
administrator.

For help with enabling IPv6 and configuring settings, see “Enabling
IPv6” on page 27.
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To configure Ethernet settings

1 From the menu, click Ethernet. The Ethernet screen appears.

Logout ‘ Save/Discard Changes | Upgrade Software | Help |

Mavigation Menu Secure IF30 RFID Reader Configuration

=1
e che:oet Submit Changes

1P6 Configuration

B RFID Moduls

DHCP Made Use DHCP if IP Address is Zero [V]
B network Services
B B Network Managament 1P Address 136.179.85.106
B B Security 1P Subnet Mask 25E 255 255 0
|
B @ Maintenance IP Router [Gateway) 136.179.85.1

DSMetwork Services

Link Speed Auto Select

Copyright @ 1995-2006 Intermec & Technologies Corparation. All rights reserved.

2 Configure the Ethernet settings. For help, see the next table.

Note: Different settings appear in this screen depending on the
§ current DHCP mode for the IF30.

If you need to configure DNS/Network Services settings, such as
DNS addresses or suffixes, or a SYSLOG destination, see
“Configuring Network Services” on page 28.

3 Click Submit Changes to save your changes. To activate your
changes, from the menu bar click Save/Discard Changes, and
then click Save Change and Reboot. For help, see “Saving
Configuration Changes” on page 16.
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Ethernet Setting Descriptions

Parameter
DHCP Mode

DHCP
Server Name

DHCP User Class

DHCP
Vendor Class

IP Address

IP Subnet Mask
IP Router

(Gateway)
Link Speed

26

Description

Sets the DHCP mode for the IF30:
* Choose Always Use DHCP if you want the IF30 to
get its IP address from a DHCP server.

* Choose Use DHCP if IP Address is Zero if you
want the IF30 to use DHCP whenever its IP address is
set to 0.0.0.0. If you choose this option, make sure the
IP address is set to 0.0.0.0.

* Choose Disable DHCP if you want to assign a static
IP address to the IF30.

Name of the DHCP server. The IF30 accepts lease offers
from only this server.

(Optional) User class for this DHCP server.
(Optional) Vendor class for this DHCP server.

IP address of the IF30 Ethernet connection. The IP
address has the form x.x.x.x, where x is a number from 0
to 255.

Set this value to 0.0.0.0 if you set the DHCP Mode to Use
DHCP if IP Address is Zero.

Set this value to a static IP address for the Ethernet
connection if you disabled DHCP.

Subnet mask for this network. The subnet mask has the
form x.x.x.x, where x is a number from 0 to 25S5.

IP address of the router. The IP address has the form
x.x.x.x, where x is the number from 0 to 255.

Choose the speed and duplex mode you want the IF30 to
use when it communicates with the Ethernet network.

If you want the IF30 to auto-negotiate this field, choose
Auto Select. Auto Select should work for most networks.
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To enable IPv6 for your Ethernet connection, in the menu click
Ethernet > IPv6 Configuration.

Check the check box to enable IPv6, or uncheck the check box to
disable IPv6.

Click Submit Changes to save your changes. The IPv6
Configuration screen appears.

If you want to enable IPv6 autoconfiguration, click Enable
Autoconfiguration and continue with Step S.

If you do not want to enable IPv6 autoconfiguration:

a Click Submit Changes. The screen refreshes with a list of IPv6
configuration settings.

b Configure IPv6 settings. For help, see the next table.

Click Submit Changes. To activate your changes, from the menu
bar click Save/Discard Changes, and then click Save Changes
and Reboot. For help, “Saving Configuration Changes” on
page 16.

IPv6 Settings Descriptions

Parameter Description

IPv6 Address A unique 128-bit IPv6 address.

IPv5 Subnet Mask The IPv6 subnet mask. Range is 1 to 128 bits.
IPv6 Router A unique 128-bit address for an IPv6 router.
(Gateway)
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Configuring Network Services

28

This section explains how to configure these network service settings
using the web browser interface:

Hostname

Domain Name Server (DNS) addresses 1 and 2
DNS suffixes 1 and 2

SYSLOG destination

To configure network services

1

From the menu, click Network Services. The Network Services
screen appears.

Logout ‘ Save/Discard Changes | Upgrade Software ‘ Help |

Mavigation Menu IF30 RFID Reader Configuration

B @ Ethemnet 0
L) izme Submit Changes
B RFID Module
= @ Network Services
Hostname: if3006200500224
SNTP Corfiguration
B @@ network Management Domain Name
B Securty DMS Address 1 0000
B8 Maintenance
DNS Address 2 0.0.0.0

DMS Suffir 1

DMS Suffir 2

S¥SLOG Destination

Configure settings. For help, see the next table.

Click Submit Changes to save your changes. To activate your
changes, from the menu bar click Save/Discard Changes, and
then click Save Changes and Reboot. For help, see “Saving
Configuration Changes” on page 16.
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IPvé6 Settings Descriptions

Parameter

Hostname

DNS Address 1

DNS Address 2

DNS Suffix 1

DNS Suffix 2

SYSLOG
Destination

IF30 Fixed Reader User’s Manual

Description

Name for this device. The default is the configuration
string for this IF30.

The hostname can be either a simple hostname, or a
qualified domain name (FQDN). If this device obtains its
IP address via DHCP, this parameter is sent to the DHCP
server. If the server supports it, this field is used for
dynamic DNS updates.

Enter the IP address of a domain name server that the
IF30 uses to resolve DNS names.

Enter the IP address of a domain name server that the
IF30 uses to resolve DNS names if the DNS server at DNS
Address 1 is not responding,.

Enter a domain name suffix that will be appended to
DNS names that cannot be resolved.

Enter a domain name suffix that will be appended to
DNS names that cannot be resolved either by themselves
or using DNS suffix 1.

Domain name or IP address of the SYSLOG server. In
Unix networks, system messages are logged to this server.
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Configuring SNTP Client Settings

This section explains how to configure Simple Network Time
Protocol (SNTP) client parameters. For information on public NTP
servers, see http://ntp.isc.org.

To configure SNTP settings

1 From the menu, click Network Services > SNTP Configuration.
The SNTP Configuration screen appears.

Logout | Save,/ Discard Changes | Upgrade Software | Help |

D e B » D ( All0
Mavigation Menu Secure IF30 RFID Reader Configuration
Ethernet 7
= Submit Changes
Bl @@ RFID Module
El" B Network Services

SMTP Server Mame 1
SNTP Configuration

B B Network Management SMTP Server Mame 2
' B securty Time Zone il
B B mMantenance

2 Enter SNTP information: In the SNTP Server Name 1 and SNTP
Server Name 2 fields, enter the DNS name or the IP address of an
SNTP or NTP server.

3 Click Submit Changes to save your changes. To activate your
changes, from the menu bar click Save/Discard Changes, and
then click Save Changes and Reboot. For help, see “Saving
Configuration Changes” on page 16.

Configuring Security

30

The IF30 supports security features to help maintain the integrity of
your secure network. You can:

* enable/disable access methods. For help see the next section
“Controlling Access to IF30 Menus.”

* change the default user name and password. For help, see “Setting
Up Logins” on page 33.
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* use a password server to maintain a list of authorized users who
can configure and manage the IF30. For help, see “Setting Up
Logins” on page 33.

Controlling Access to IF30 Menus

You can enable or disable the web browser interface (HTTP or
HTTPS) depending on how you want users to be able to configure or
manage the IF30. For help, see “Access Method Descriptions” on
page 32.

To enable or disable the web browser interface

1 From the menu, click Security. The Security menu appears.

Logout ‘ Save/Discard Changes | Upgrade Software ‘ Help |

Mavigation Menu Secure [F30 RFID Reader Configuration
-
B Ethernet Submit Changes
- @ RFID Module
- @@ Metwork Services
Browser ACCess Enabled (Port 80/443) [V]
- @ nMetwork Management . X .
. Reject Expired Certificates O

m

- Security
; Passiwords

Certificate Details

m

H @@ Mainkenance

2 Enable or disable the web browser interface

3 Click Submit Changes to save your changes. To activate your
changes, from the menu bar click Save/Discard Changes, and
then click Save Changes and Reboot. For help, see “Saving
Configuration Changes” on page 16.
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Access Method Descriptions

Method

Browser Access

Reject Expired
Certificates

Description

Determines if users can use a web browser to configure or
manage the IF30. Browser access is through port 80 or port
443,

Choose Secure-Only if you want users to log in only
using the secure web browser (HTTPS) interface. Secure-
Only access is through port 443.

If you disable browser access to the IF30, you may need to
use a communications program to configure and manage
the IF30. For help, see “Using a Communications
Program” on page 10.

Check this check box if you want the IF30 to reject
certificates that have expired. For help, see “Rejecting
Expired Certificates” on page 39.
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Setting Up Logins

To ensure login security for configuring or maintaining the IF30, you
should use a password server or change the default user name and
password.

A password server is typically an embedded authentication server
(EAS) or other RADIUS server. To use a password server, you must
have a password server on the network that contains the user name/
password database. On the IF30, you need to enable RADIUS for
login authorization.

When a user attempts to log in to the IF30, the user must enter a user
name and password. This login is sent to the RADIUS server, which
compares the login to its list of authorized logins. If a match is found,
the user can log in to the IF30 with read/write privileges.

If no RADIUS server is available when the user tries a login and the
Allow Service Password check box is checked, the server checks the
service password. If the login does not match the service password, the
login fails.

For help, see the next section, “Configuring the IF30 to Use a
Password Server.”

If you do not want to use a password server, you should change the
default login user name and password, and create a read-only
password. For help, see “Changing the Default Login” on page 35.
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Configuring the IF30 to Use a Password Server

If you use a password server to manage users who can log in to this
IF30, you need to tell the IF30 how to communicate with the
password server and then you need to configure the password server.

To configure the IF30 to use a password server

1 From the menu, click Security > Passwords. The passwords

screen appears.

Logout | Save/Discard Changes ‘ Upgrade Software | Help |

Security/Passwords/

Mavigation Menu

IF30 RFID Reader Configuration

H- @ Ethernet
- B RFID Module

I = = e

H

- @ Metwork Services

H- @ Metwork Management
=)

]

- - Security
: Passwords

Certificate Details

B @ Mairtenance

Submit Changes

Use RADIUS for Login Authorization

Lser Marme
Passward

Read Only Password

Allowe Service Password

0

2 Check the Use RADIUS for Login Authorization check box.

3 Click Submit Changes to save your changes.

4 Click Select a RADIUS Server for Login Authorization. The

RADIUS Server List screen appears.

Logout | Gave/Discard Changes | Upgrade Software | Help ‘

Security/RADIUS Se

Navigation Menu

B B8 Ethernet

- @ RFID Module

bl B Metwork Services

H- @@ petwork Management

= @ security

: Passwiords

RADIUS Server List

Certificate Details

B @@ Maintznance

IF30 RFID Reader Configuration
Submit Changes
Primnary Server Retry Time 0:00:00
IP Address/DNS Name Secret Key
Server 1 AR
Server 2 AR
Server 3 R
Server 4 R
Server 9 SR
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5 For each password server, enter the IP address or the DNS name,
enter the shared secret key and port number.

password servers act as backup servers. The IF30 uses the first
password server (starting with Server 1) whose IP address/DNS
name and secret key are the same as the one in the list.

§ Note: If you enter more than one password server, the other

6 Configure the password server database. For help, see the
documentation that came with your server.

Changing the Default Login

If you are not using a password server to authorize user logins,
Intermec recommends that you change the default user name and
password and create a read-only password.

To set up logins

1 From the main menu, click Security > Passwords. The Passwords
screen appears.

Logout | Save/Discard Changes ‘ Upgrade Software | Help |

Security/Passwords/

Mavigation Menu IF30 RFID Reader Configuration
B @ Ethernet .

L) B Submit Changes
B @ RFID Module
ez} i

B network services Use RADIUS for Login Authorization O
- B rehwork Management
B B security Liser MNarme

; Passwords Password sebideicliclk

Certificate Details

Read Only Password

- @ Maintenance
Al Service Password

Clear the Use RADIUS for Login Authorization check box.
Click Submit Changes to save your changes.

Configure the parameters. For help, see the next table.

vn A W N

Click Submit Changes to save your changes. To activate your
changes, from the menu bar click Save/Discard Changes, and
then click Save Changes and Reboot.

For help, see “Saving Configuration Changes” on page 16.
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Password Parameter Descriptions

Parameter

Use RADIUS for
Login Authorization

User Name

Password

Read Only Password

Allow Service
Password

36

Descriptions

Determines if you are using a password server to
authenticate logins to this IF30. Uncheck this check
box if you are not using a password server.

Enter the user name you need to use to log in to this
IF30. The user name can be from 0 to 32 characters
long.

If you leave the user name and password fields blank,
a user will not need to log in to the IF30.

Enter the password you use to log in to this IF30. This
password gives you read and write access to the IF30
configuration. The password can be from 0 to 32
characters long.

If you leave the user name and password fields blank,
a user will not need to log in to the IF30.

Enter the password you need to use to log in to this
IF30. This password gives the user read-only access to
the IF30. This user can view the configuration and
execute diagnostics but cannot perform any tasks
that affect IF30 operation, such as changing
configuration options or downloading software.

To disable this password, delete it.

If the user enters a login that does not match either
the user name and password or the read only
password, this setting (enabled by default) allows the
login to be checked against the service password.
Intermec Product Support may use this service
password if they need to troubleshoot this IF30.

If this feature violates your security guidelines, you
may disable the service password by unchecking the
check box. If you disable the service password and
forget your normal password, you will need to contact
Product Support for instructions on resetting all
passwords to default values.
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The default server certificate on the IF30 (ValidForHTTPSONLY)
supports the secure web browser interface. You can use a third-party
CA to issue unique client certificates and a root certificate.

Viewing Certificates

You can use the web browser interface to view the certificates loaded

on the IF30.

To view certificates

* From the menu, click Security > Certificate Details. The
Certificate Details screen appears.

Logout ‘ Save/Discard Changes | Upgrade Software | Help ‘

Security/Certificate

Navigation Menu

IF30 RFID Reader Configuration

B @ Ethernet
B RFID Maduls
B B Network Services
B Metwork Management
= B Security
Passwords
Certificate Details

& @ Maintenance

Server Certificate

Status Default
Carmman Marme{CN) ValidForHT TRSOnly
Issuer Cornmon Mame{CN)  Intermec Technologiss Corporation Root Certificate
walid From Oct 30 12:50:50 2002 GMT
Walid To Qct 30 12:50:50 2037 GMT

CA Certificate

Status Installed
Comman Mame(Ch) Intermec Technologiss Corporation Root Certificate
Issuer Cornmnon Mame(CN)  Intermec Technologies Corporation Roat Certificate
walid From Jul 3 18:58:05 2002 GMT
Walid To Jul 3 18:98:05 2037 GMT

The Server Certificate table lists the server certificate that is
installed, and the CA certificate table lists the trusted CA
certificate that is installed.

IF30 Fixed Reader User’s Manual
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Installing and Uninstalling Certificates

Once you have determined that you need to install or uninstall a
certificate, use this procedure.

certificate and the trusted CA certificate. You need to contact your

& Note: If you uninstall all certificates, you lose the unique server
local Intermec representative to purchase new certificates.

To install certificates

1 Click Install certificates in the certificates store. The Certificate
Import screen appears.

prompted to log in again. Click A secure session is available and
log in to the IF30. If a Security Alert dialog box appears, click Yes
to proceed. Repeat the above procedure.

§ Note: If you are not using a secure web browser, you will be

2 Click Server Certificate or Trusted CA Certificate.

3 In the Enter or select the name of the certificate file to import
field, enter the path to and filename of the server certificate. Or
click Browse to find the certificate.

4 (Server Certificate only) In the Enter the associated passphrase
for this certificate field, carefully enter the passphrase for the
certificate.

5 Click Import Certificate. If a Security Alert dialog box appears,
click Yes to proceed.

To uninstall certificates

1 From the main menu, click Security > Certificate Details. The
Certificate Details screen appears.

2 To uninstall certificates, click Uninstall all certificates. The
unique server certificate and the trusted CA certificate are deleted.
You can still use the secure web browser interface and install new
certificates using the default certificate (ValidForHTTPSOnly).
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Rejecting Expired Certificates

By default, when you install a certificate the IF30 does not validate the

certificate dates against the date currently set in the IF30 operating
system. Follow the next procedure to set the IF30 to reject expired
certificates.

To set the IF30 to reject expired certificates

1 From the menu, click Security. The Security screen appears.

Logout ‘ Save/Discard Changes | Upgrade Software ‘ Help |

Mavigation Menu Secure [F30 RFID Reader Configuration
[ Ethernet 3
L Submit Changes
- B RFID Madule
Bl B metwork Services 1
Browyser Arress Enabled (Part 80/443)
- @@ retwork Management )

Reject Expired Certificates
= Security D

Passmords

Certificate Details

B @ Maintenance

2 Check the Rejected Expired Certificates check box.

3 Click Submit Changes to save your changes. To activate your
changes, from the menu bar click Save/Discard Changes, and
then click Save Changes and Reboot. For help, see “Saving
Configuration Changes” on page 16.
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Creating and Using RFID Applications

This chapter explains how you can use RFID applications for
the IF30 and includes these topics:

RFID Applications and the IF30
Creating Applications for the IF30
Configuring RFID Settings

Configuring the Data Collection Engine

11
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RFID Applications and the IF30

An RFID application communicates with the IF30 through the Data
Collection Engine (DCE), and controls the reader by issuing Basic
Reader Interface (BRI) commands.

* For more information on the DCE, see “Configuring the Data
Collection Engine” on page 49.

* For more information on the BRI, see the Basic Reader Interface
Programmer’s Reference Manual.

Creating Applications for the IF30

An RFID application can communicate directly with the IF30 DCE
using the BRI protocol. For more information, see “Configuring the
Data Collection Engine” on page 49.

To develop RFID applications for the IF30, you will need to write and
test your RFID applications on a development workstation (your
desktop PC). The application can access the IF30 via TCP on port
2189.

Configuring RFID Settings

This section explains how you use the web browser interface to change
the settings for the IF30 RFID module. As you install and test
applications, you can configure the RFID settings for the best system
performance.

To change RFID module settings

1 From the menu, click RFID Module. The RFID Module screen
appears.
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Intermec-
@ RFID
! Logout | Save/Discard Changes | Upgrade Software ‘ Help ‘
RFID od
Mavigation Menu IF30 RFID Reader Canfigurstion
B @ Ethernet .
L) e Submit Changes
El i@ RFID Module
DCE Configuration Supported Tag Type (150) -
B Hetwork Services -
Supported Tag Type (Gen 2) EPC Class 1 Gen2
B nstwork Management -
Dense Reader Mode
] Security D
B @ Maintenance LBT Channel 5
LBT Scan Enable
Field Separator Space ()
ID Report
Mo Tag Report
Timeout Configuration Mode |
ID Tties 3
antenna Tries 1
Report Timeout 0
Read Tries 3
write Tries 3
Iritialization Trigs 1
Lock Tries 3
Select Tries 1
Unselect Tries 1

2 Change RFID settings as needed. For help, see the next section.

3 Click Submit Changes to save your changes. To activate your
changes, from the menu bar click Save/Discard Changes, and
then click Save Changes and Reboot. For help, see “Saving
Configuration Changes” on page 16.

Note: If you make changes to RFID settings, you need to reboot
§ the IF30 to activate the changes.
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About RFID Module Settings

44

This section explains the module settings. Most settings have BRI
attribute equivalents. For more information, see the Basic Reader
Interface Programmer’s Reference Manual.

Supported Tag Type

Sets the type of tag for RFID operations. Certain performance
improvements can be realized if you choose the best setting for your
system. The more specific the selection, the better the performance.
See the next table for more information.

Tag Type Descriptions

Tag Type Description

Phillips v1.19 Phillips v1.19

ISO6B/G1 ISO6B Generation 1
ISO6B/G2 ISO6B Generation 2
EPC Class 1 Gen 2 (default) EPCglobal Class 1 Gen 2

This setting is equivalent to the TAGTYPE BRI attribute.

Supported Tag Type (Gen 2)

Enables or disables Gen 2 tag support for RFID operations. Choose
EPC Class 1 Gen 2 (default) to enable Gen 2 support, or None to
disable Gen 2 support.

Dense Reader Mode

Check this check box to enable Dense Reader mode, which is only
supported by EPC Class 1 Gen 2 tags. When dense reader mode is
enabled, these tags respond with Miller Sub carrier encoded data
instead of FMO encoded data.

This setting is equivalent to the DENSEREADERMODE BRI
attribute.
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LBT Channel

Sets the default transmit channel of the available ETSI 302-208
channels. When you enable LBT scanning, the channel scan sequence
starts with this LBT channel. When LBT scanning is disabled, (as in
the 4 channel mode) the LBT channel is the only channel used. The
range for 10 channel mode is 4 to 13.

The default for 10 channel mode is 8, and for 4 channel mode the
defaultis 7.

The valid values in 4 channel mode are 4, 7, 10, 13.
This setting is equivalent to the LBTCHANNEL BRI attribute.

LBT Scan Enable
LBT scanning is enabled, by default in ETSI 10 Channel mode in
accordance with 302-208.

Note: LBT scanning is permanently disabled in ETSI 4 channel mode
§ in accordance with 302-208 v1.2.1.

When LBT scanning is enabled, the algorithm scans the available
ETSI 302-208 channels for a free transmit channel.

In continuous read mode, the scan sequence begins with the channel
specified by LBTCHANNEL and every third channel is checked (for
example, 8,11,4,7,10,13,6,9, 12, 5) until a free channel is found. If a
free channel is not found, LBT repeats the scan sequence.

In single-shot read mode, LBT scanning goes through all available
channels at once. If no free channel is found, the reader will report
“NOTAG” and abort the inventory operation.

When LBT scanning is disabled, the IF30 does not scan for a free
transmit channel, and the transmit channel is set by the
LBTCHANNEL BRI attribute.

This setting is equivalent to the LBTSCANENABLE BRI attribute.

Field Separator
Sets the space character to be used for separating fields in tag data.
Choose either space () or comma (,). Default is space.

This setting is equivalent to the FIELDSEP BRI attribute.
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ID Report
Enables or disables tag ID reporting after a Read, Write, or Lock
command is executed:

* ForISO tags, the tag identifier corresponds to TAGID.
* For EPC tags, the tag identifier corresponds to EPCID.
Check the check box to enable tag ID reporting.

This setting is equivalent to the IDREPORT BRI attribute.

No Tag Report

Enables or disables a NOTAG message, which is sent when no tags are
found during execution of a Read, Write, or Lock command. Check
the check box to enable the message.

This setting is equivalent to the NOTAGRPT BRI attribute, and is
enabled by default.

Timeout Configuration Mode

Enables a timeout mode. Instead of specifying the number of antenna
or ID tries, you specify a timeout value. If the IF30 does not find any
tags after an antenna or ID try, the reader waits for the specified time
before starting the next antenna or ID try.

This setting is equivalent to the TIMEOUTMODE BRI attribute, and
is disabled by default.

To enable Timeout Configuration Mode

1 Check the check box and then click Save Changes. The screen
refreshes. The Antenna Tries setting is replaced by Antenna
Timeout, and the ID Tries setting is replaced by the ID Timeout.

2 Specify the value (in ms) for the timeout in the entry fields and
then click Save Changes.

ID Tries
Sets the maximum number of times the reader executes the identify
algorithm before a response is returned to a Read or Write command.

In practice, this is the number of times a tag ID attempt is made for
each antenna being used. Valid range is 1 to 254. Default is 3.

This setting is equivalent to the IDTRIES BRI attribute.
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Antenna Tries
Sets the maximum number of ID Tries that the reader executes per
antenna. Valid range is 1 (default) to 254.

This setting is equivalent to the ANTTRIES BRI attribute.

Read Tries
Sets the maximum number of times the read algorithm is executed
before a response is returned to a Read command.

In practice, this is the number of times an identified tag will be read
until the read is successful. Valid range is 1 (default) to 254.

This setting is equivalent to the RDTRIES BRI attribute.

Write Tries
Sets the maximum number of times the write algorithm is executed
before a response is returned to a Write command.

In practice, this is the number of times an identified tag will be
written until the write is successful. Valid range is 1 to 254. The
default is 3.

This setting is equivalent to the WRTRIES BRI attribute.

Initialization Tries
Sets the maximum number of times the reader attempts to initialize a
tag. Valid range is 1 (default) to 254.

This setting is equivalent to the INITTRIES BRI attribute.

Lock Tries

Sets the maximum number of times the lock algorithm is executed
before a response is returned to a Lock command. Valid range is 1 to
254. The default is 3.

This setting is equivalent to the LOCKTRIES BRI attribute.

Select Tries

(Not supported by EPCglobal Class 1 Gen 2 tags) Sets the number of
times a group select is attempted. A group select is the command that
starts the identity process. Valid range is 1 (default) to 254.

This setting is equivalent to the SELTRIES BRI attribute.
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Unselect Tries
(Not supported by EPCglobal Class 1 Gen 2 tags) Sets the number of
times a group unselects is attempted. Valid range is 1 (default) to 254.

This setting is equivalent to the UNSELTRIES BRI attribute.

Initial Queue

(EPCglobal Class 1 Gen 2 tags only) Sets the initial Q parameter value
used by the Query command. Valid range is 0 to 15. The default is 4. If
you know there is only one tag in the field, set this attribute to 0 for
best performance.

This setting is equivalent to the INITIALQ BRI attribute.

Session

(EPCglobal Class 1 Gen 2 tags only) Sets the command session
parameter to the corresponding EPCglobal Class 1 Gen 2 air protocol
command (default is QueryAdjust).

This setting is equivalent to the SESSION BRI attribute. For more
information on this setting, see the EPCglobal Class 1 Gen 2
documentation.

Field Strength
Sets the RF power level (measured as a percentage of maximum
power) for all antennas. Valid range is 1 to 100 (default).

Use this setting to antennuate the antenna field strength. In some
situations, full output power can cause unnecessary interference. For
example, if the tag is close to the antenna, full output power might
overload the tag and cause unreliable behavior.

This setting is equivalent to the FIELDSTRENGTH BRI attribute.

Enable Antenna Port n

Enables or disables the antenna connected to antenna port n. Check
the check box to enable that antenna. Antenna Port 1 is enabled by
default.

If more than one antenna is enabled, the antennas always fire in
sequence numerically (1, 2, 3, 4). To change this sequence, you need to
set the ANTS BRI attribute. For more information, see the BRI
programmer’s reference manual.
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Configuring the Data Collection Engine

The IF30 data collection engine (DCE) handles communication
between your application and the RFID module. It allows up to 10
applications to use the same reader simultaneously.

When your application is communicating with the DCE, the blue
Intermec Ready-to-Work Indicator on the IF30 front panel turns on
and stays on. For help, see “Learning About the Intermec Ready-to-
Work Indicator” on page 7.

You can configure many settings for the DCE. For help, see the next
procedure.

To configure DCE settings

1 From the menu, click RFID Module > DCE Configuration. The
DCE Configuration screen appears.

Logout | Save/Discard Changes ‘ Upgrade Software | Help |
RFID Module/DCE Configuration/

Navigation Menu Secure IF30 RFID Reader Configuration
B @ Ethernet -
L) g Submit Changes
=) B RFID Module
DCE Configuration Allow External BRI Connections

B @ etwark Services

- B Mebwork Management ERINTGRIROM 2188

B Security ERI Heartbeat 0

B @ Maintenance Trigger Management 0
Allow External ERC Connections
EPC TCP Part 4684
Enable Logging 0
| Display Log | | Display Statistics ‘ ‘ Dump Snapshots |

2 Change DCE settings as needed. For help, see the next table.

3 Click Submit Changes to save your changes. To activate your
changes, from the menu bar click Save/Discard Changes, and
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then click Save Changes and Reboot. For help, see “Saving
Configuration Changes” on page 16.

DCE Configuration Parameter Descriptions

Parameter

Allows External
BRI
Connections

BRI TCP Port

BRI Heartbeat

Trigger
Management

Allow External
EPC
Connections

EPC TCP Port

Enable Logging

Description

Enables/disables external TCP connections to the DCE BRI
server.

Specifies the TCP port used for incoming BRI connections
to the DCE. This port must be unique for all TCP services
running on the IF30. Valid range is 0 to 65535. Default is
2189.

Enables/disables asynchronous heartbeat event (EVT:

HEARTBEAT BRI STRING). When enabled, the IF30 sends
the heartbeat event every 30 seconds, enhancing the IF30’s
ability to detect TCP sessions that were not closed cleanly.

Enables DCE control of trigger states.

When Trigger Management is enabled, the DCE manages
the triggers so your application never needs to issue a
TRIGGERREADY command.

When Trigger Management is disabled, your application
must manage issuance of the TRIGGERREADY command.

Enables/disables external TCP connections to the DCE
EPC server. When this box is not checked, the DCE accepts
EPC connections only from applications residing on the
1F30.

Specifies the TCP port used for incoming EPC Reader
Protocol connections to the DCE. This port number must
be unique for all TCP services running on the IF30. Valid
ranges is 0 to 65535. Default is 4684.

Enables/disables logging of commands sent and received
through the DCE.

Viewing the DCE Events Log

If you enable DCE logging, you can see a list of commands sent and
received through the DCE. You can save the logfile as a .txt file.

50

To enable DCE logging and view the logfile

1 From the menu, click RFID Module > DCE Configuration. the
DCE Configuration screen appears.
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2 Check the Enable Logging check box.

3 Click Submit Changes to save your changes. To activate your
changes, from the menu bar click Save/Discard Changes, and
then click Save Changes and Reboot. For help, see “Saving
Configuration Changes” on page 16.

4 After the IF30 reboots, click Refresh in the browser menu. The
login screen appears.

5 Enter your user name and password, and then click Login. The
TCP/IP Settings screen appears.

6 From the menu, click RFID Module > DCE Configuration. The

DCE configuration screen appears.

7 Click Display Log, the DCE Configuration/Display Log screen
appears with a list of command events.

Logout ‘ Save/Discard Changes | Upgrade Software | Help |

Navigation Menu

Secure IF30 RFID Reader Configuration

" B ethernet
- 8 RFID Module

DCE Configuration
BB Metwork Services
“ﬁ Metwork Management
B securty
B Maintenance

Time/Date

Connection Type Hessage

8 To save the log file, click Download Logfile and then choose File
> Save As. Follow the prompts to save the log file to your desktop

PC.
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DCE Log Command Event Descriptions

Event Name Description

Time/Date Time and date of the event.
Connection TCP port of the event. 0 indicates a serial connection.
Type Message type of the event, generally indicating which

system sent the message:

1 - Message from the RFID module to the DCE.
2 - Message from the DCE to the RFID Module.
3 - Message from the application to the DCE.

4 - Messages from the DCE to the application.

Types 1 and 2 are suffixed by the message checksum value
used by the reader module to detect errors.

Message Text of the message, including responses.

Viewing DCE Statistics

52

You can use the web browser interface to view a list of DCE statistics.

To view DCE statistics
1 From the menu, click RFID Module > DCE Configuration. The
DCE Configuration screen appears.

2 Click Display > Statistics. The DCE Configuration/Display
Statistics screen appears with a list of DCE statistics.

Logout ‘ Save/Discard Changes ‘ Upgrade Software ‘ Help ‘

RFID Module/DCE Configuration/Display Statistics/

Mavigation Menu Secure IF30 RFID Reader Configuration

B Ethermst
= @@ RFID Module
DCE Configuration —
B ietwork Services g;? E::;;n;;:lfn/za/znns 21:05:38)
B network Management Current Allocations: 5, Max illocations: 7
B secuity kllocate: 55, Free: 50, Overflow: 0, Underflow: O
BRI Event Pool:

B Haintenance Current Allocations: 1, Max Allocations: 1

illocate: 34, Free: 33, Overflow: 0, Underflow: O
BRI TCP Client Pool:

Allocate: success=1, fail=0

Free: success=0, fail=0

Pool (Local): current=0, total=10

Pool (Remote): current=0, total=10

Pool (Administrator): current=1, total=3
EFC TCP Client Pool:

Rllocate: success=0, fail=0

Free: success=0, fail=0
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3 To save the list, click Download Statistics File and then choose

File > Save As in the browser menu. Follow the prompts to save
the list to your desktop PC as a .txt file.
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Managing, Upgrading, and
Troubleshooting the IF30

This chapter includes information on managing the IF30 and
includes these topics:

Managing the IF30
Using SmartSystems Foundation
Using Wavelink Avalanche

Enabling Simple Network Management Protocol
(SNMP)

Maintaining the IF30
Upgrading Firmware
Troubleshooting the IF30

Calling Intermec Product Support
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Managing the IF30

There are several methods you can use to manage the IF30. You can
use:

* aweb browser. For help, see “Using the Web Browser Interface”
on page 14. This manual assumes that you are using this method
for all procedures.

* Intermec SmartSystems Foundation. For help, see the next
section.

* the Wavelink Avalanche client management system. For help, see
“Using Wavelink Avalanche” on page 57.

* an SNMP management station. For help, see “Enabling Simple
Network Management Protocol (SNMP)” on page 59.

Using SmartSystems Foundation

The IF30 ships with a SmartSystems client, which means you can
manage it from a central host PC using Intermec’s SmartSystems
Foundation. The SmartSystems console displays all SmartSystems-
enabled devices in your network.

SmartSystems Foundation is available for free from the Intermec web
site. To download SmartSystems Foundation, go to
www.intermec.com/SmartSystems. For information on using the
SmartSystems console, in the console choose SmartSystems > Help.

Configuring the IF30 With Intermec Settings

56

This section explains how to configure the IF30 with Intermec
Settings.

To configure the IF30 with Intermec Settings

* In the console, right-click an IF30 and choose Intermec Settings
from the menu. The Intermec Settings browser appears.

For help using Intermec Settings, in the Intermec Settings browser
choose Help > Online Manual.
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Using Wavelink Avalanche

The Wavelink Avalanche client management system uses three main
components to help you easily manage your wireless network.

Avalanche Component Descriptions

Component Description

Enabler Installed on all devices that can be managed by the
Avalanche system. It communicates information
about the device to the Avalanche Agent and
manages software applications on the device.

Agent Automatically detects and upgrades all devices in the
Avalanche system and manages the daily processing
functions.

Console The administrative user interface that lets you

configure and communicate with the Avalanche
Agent. From the console, you can configure and
monitor devices and build and install software
packages and software collections.

Avalanche uses a hierarchical file system organized into software
packages and software collections:

* Software packages are groups of files for an application that
resides on the device.

* Software collections are logical groups of software packages.

For more information, see the Wavelink Avalanche documentation
and online help. Or, visit the Wavelink web site at
www.wavelink.com.
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To configure the IF30 to use Avalanche

1 From the menu, click Network Management. The Network
Management screen appears.

Logout | Save/Discard Changes | Upgrade Software | Help ‘

0 anage
Mavigation Menu IF30 RFID Reader Configuration

Bl B Ethernet
= = Submit Changes

Bl @@ RFID Module

B
B tstwark. Sarvicss Al Avalanche Access

El- @ Network Management

SHMPw3 Canfiguration Awalanche Agent Name

] Security

B Maintenance SrartSysterns Server Address
Enable SHMPyY3
Enable SMMPy 1fSHMPy2C

ShMP Community (Read-Orly)

SIMP Community (Readjwrite)

CRIMD Carnen it (Sarraty

2 Configure Avalanche settings. For help, see the next table.

3 Click Submit Changes to save your changes. To activate your
changes, from the menu bar click Save/Discard Changes, and
then click Save Changes and Reboot. For help, see “Saving
Configuration Changes” on page 16.

Wavelink Avalanche Parameter Descriptions

Parameter Description
Allow Avalanche = Enables/disables the Avalanche client management
Access system.

Avalanche Agent Specifies the IP address or DNS name of the Avalanche
Name console.

Or, leave this field blank and the IF30 sends out a
broadcast request looking for any available agent.
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Enabling Simple Network Management Protocol
(SNMP)

You can access and manage the IF30 from a Simple Network
Management Protocol (SNMP) station. Contact a representative if
you need to obtain a copy of the management information base
(MIB).

Before you can use an SNMP management station, you must define
the IF30 SNMP community strings.

To configure the SNMP community strings

1 From the menu, click Network Management. The Network
Management screen appears.

Logout | Save/Discard Changes ‘ Upgrade Software | Help |

0 anage
Mavigation Menu IF30 RFID Reader Configuration
B @ Ethernet -
B Submit Changes
B RFID Module
E- @@ Hstwork Services

B Allow Svalanche &ccess
E‘ & Network Management
i SMMPY3 Configuration Avalariche Agent Name

= Security
B B Maintenance SmartSysterns Server Address

Enable SNMPyZ
Enable SMMPy1/SHMPy2C

E ®

SMMP Cormmunity (Read-Only)

SNMP Community (Read,Write)

2 Configure the SNMP community parameters. For help, see the
table on the next page.
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3 Ifyou enabled SNMPv3, click Network Management > SNMPv3
Configuration. The SNMPv3 Configuration screen appears.

If you did not enable SNMPv3, continue with Step S.

Logout | Save/Discard Changes | Upgrade Software | Help |

0 anage

Havigation Menu

0 () atio

IF30 RFID Reader Configuration

B Ethernet
B RFID Module
Bl B Network Services
El B Network Management
| SNMPv3 Configuration
B @ Security
B Mairkenance

Submit Changes
Username
SHMPY3 Read-Only Usgr s el
SHMPYS Read/virite Lsgy s el

4 Change settings for SNMPv3. For help, see the next table.

5 Click Submit Changes to save your changes. To activate your
changes, from the menu bar click Save/Discard Changes, and
then click Save Changes and Reboot. For help, see “Saving
Configuration Changes” on page 16.

SNMP Community Parameter Descriptions

Parameter

Enable SNMPv3

Enables SNMPv1/
SNMPv2c

SNMP Community
(Read-Only)

SNMP Community
(Read/Write)

SNMP Community
(Secret)

60

Description

Enables/disables SNMPv3.
Enables/disables SNMPv1 and SNMPv2c.

Specifies a password that provides read-only access.
This password can be from 1 to 15 characters and is
case-sensitive. The defaultis public.

Specifies a password that provides read and write
access. This password can be from 1 to 15 characters
and is case-sensitive. The default is CR52401.

Specifies a password that provides read and write
access and lets the user change the community
strings. This password can be from 1 to 15
characters and is case-sensitive. The default is secret.
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SNMP Community Parameter Descriptions (continued)

Parameter Description

SNMPv3 Read-Only  Specifies a password that provides read-only access.
User This password can be from 1 to 15 characters and is
case-sensitive.

SNMPv3 Read-Write Specifies a password that provides read and write
User access. This password can be from 1 to 15 characters
and is case sensitive.

Authentication Specifies the protocol for authenticated SNMPv3

Protocol messages. This must match a supported
authentication protocol on the SNMP management
station.

Data Privacy Protocol Specifies the protocol for encrypted SNMPv3
messages. This must match a supported encryption
protocol on the SNMP management station.

Maintaining the IF30

The Maintenance menu lets you view IF30 parameters and
characteristics, including:

* port statistics.
» alist of logged events.
* aconfiguration summary.

You may need this information when you call Intermec Product
Support.

Viewing Port Statistics

The Port Statistics screen shows the total number of packets and
bytes the IF30 has received and transmitted since it was last booted.
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To view port statistics

* From the menu, click Maintenance > Port Statistics. The Port

Statistics screen appears.

Logout | Save/Discard Changes | Upgrade Software | Help ‘

Maintenance/Port Statistics/

Mavigation Menu

IF30 RFID Reader Configuration

- @ Ethernet
B RFID Module
B metwiork Services

B network Management
0 -] Security
B B Maintenance

Port Statistics

Ewents Log
About This IF30 RFID Reader

Viewing the Events Log

Ethernet

Packets Errors Drops FIFD Errors Frame Error Mo
Ry 436929 o o o o

Packets Errors Drops FIFO Errors Collisions Carr
Tx 19654 0 0 0 0

The Events Log screen shows the events that have been logged by the
IF30. These events are cleared when the IF30 loses power or is

rebooted.

To view the events log

* From the menu, click Maintenance > Events Log. The Events Log

screen appears.

Logout | Save/Discard Changes | Upgrade Software | Help ‘

Mavigation Menu

IF30 RFID Reader Configuration

B @ Ethernet
B RFID Moduls

B retwork Services

B network Management
H = Security

El & Maintenance

Port Statistics
Events Log
About This IF30 RFID Reader

Mo events have been logged

62
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Viewing the About This IF30 RFID Reader Screen

The About This IF30 RFID Reader screen summarizes the
configuration settings for the IF30 and includes a list of software
versions, serial numbers, and other IF30-specific information. Any
changes from the default configuration that have been made to the
IF30 appear in blue.

To view the About This IF30 RFID Reader screen

e From the menu, click Maintenance > About This IF30 RFID
Reader. The About This IF30 RFID Reader screen appears.

Logout | Save/Discard Changes ‘ Upgrade Software | Help |

efAbo 30 RFID Reader/

Mavigation Menu IF30 RFID Reader Configuration
B Ethernet
B RFID Madule

B network Services

B

B

Copyright ©@ 1995-2006 Intermec ® Technologies Corpm

B @@ hebwork Management reserved,
= B Maintenance
Port: Statistics The 'Find This IF30" button will cause the LEDs to blink ina L

The two outer LEDs will be unchanged; the inner LEDS will all

DHCP Status This feature is intended to help physically locate this

Ewents Log
About This IF30 RFID Reader Boot code version 6,90
Code version 120
Software Release 1.00
Serial Mumber 07200500013
Configuration String if30a00000000012
Total Running
Processes =B
Total flash memory 16777216 Bytes
Total RAM
(Userspace) 31551488 Bytes
Aailable RAM 12450456 Bytes
0:00:11:35
SSEmEEnE (Days:Hours: Minutes: Secon
Systemn time Friday, January 19, 2007 16:2
RFID Module
Firrmware version 6.33

You can use the LEDs to help locate a specific IF30 in your location.
To locate the IF30

e On the About This IF30 RFID Reader screen, click Find This
IF30. The middle three LEDs on the IF30 start flashing, while the
two LEDs on the end are unchanged. The LEDs flash until you
click Finished Finding IF30.
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Viewing the IF30 Configuration Summary
The About This IF30 RFID Reader screen includes a summary that

shows basic parameter settings. Parameters that have been changed

from the default configuration appear in blue.

Configuration Summary

| Display &ll Configuration Settings

Ethernet

DHCP Mode Alweays Lse DHCP
RFID Module

DCE Configuration

Allowe External BRI Connections
Enable Logging "
Supported Tag Type (IS0 Phillips w1,19

Follow the next procedure to see a complete list of settings.

IF30 Fixed Reader User’s Manual



Chapter 4 — Managing, Upgrading, and Troubleshooting the IF30

To view all IF30 configuration settings

e In the About This IF30 RFID Reader Screen, scroll down and click
Display All Configuration Settings. The screen refreshes and
shows a list of complete settings.

Configuration Summary

| Display Only Differences From Defaults |

Ethernet
DHCP Mode Lze DHCP if IP Address is Zero
IP Address 136,179.85.105
IP Subnet Mask 255.255.255.0
IP Router (Gateway) 136,179,85.1
IPv6 Configuration
Enable IPvE
Link Speed Auto Select
RFID Module

DCE Configuration

Allow External BRI Connections X
BRI TCP Port 2189
BRI Heartbeat

Trigger Managerment

Allowy External EPC Connections X
EPC TCP Port 4684
Enable Logging
Supported Tag Type (150 Mone
Supported Tag Type (Gen 2) EPC Class 1 Gen2

Dense Reader Mode

To hide parameter settings that have not been changed

* Click Display only Differences From Defaults. The screen
refreshes and shows only parameters changed from the default
values.
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Restoring the IF30 to the Default Configuration

1 From the menu, click Save/Discard Changes. The Save/Discard
Changes screen appears.

Logout ‘ Save/Discard Changes ‘ Upgrade Software ‘
Save/Discard Changes
Navigation Menu IF30 RFID Reader Configuration

H B Ethemet
£ @ RFID Module

™ . | Save Changes and Reboot ‘ ‘ Discard Changes and Reboot |
Mebwork Services
H- @ Mebwork Management
- B security Save Changes without Reboot
£ B Mairtenance
Discard Pending Changes ‘ ‘ Restore Factory Defaults

Possible Configuration Errors
The login password has not been changed from its default value,

2 Click Restore Factory Defaults. A list of parameters that will be
changed appears in the Pending Changes list.

3 Click Save Changes and Reboot. The IF30 reboots and the
default configuration is restored.

Upgrading Firmware

This section explains how to import and install the IF30 and RFID
firmware upgrades to the IF30.

Note: To upgrade the firmware, use only files provided by Intermec.
§ Be sure to contact your Intermec RFID system consultant before

upgrading.

Make sure the IF30 is connected to a reliable AC power source
A before you upgrade the firmware. Do not cycle power to the IF30
during the upgrade. If AC power is lost during the upgrade, the

Caution 130 may require factory repair.
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To upgrade the firmware

1 From the menu, click Upgrade Software. The Upgrade Software.
The Upgrade Software screen appears.

Logout | Save/Discard Changes ‘ Upgrade Software |

pgrade off

Mavigation Menu

IF30 RFID Reader Configuration

B Ethernet
B RFID Module
- B Metwork Services

- B Security

S B Mairkenance

- B Metwork Management

Warning: Do not close or navigate away from this page during upload.

Enter or select the name of the firmware upgrade file:

Browse

Transfer upgrade file to IF30 |

Before upgrading the firmweare, you must obtain an upgrade file from our web site. Enter the file
name in the input field above or click the "Browse..." button to open a file selection dialog. Yhen
the correct fle name is displayed in the input field, click the "Upgrade” button to start the
upgrade.

The upgrade wil take up to three minutes to complete, Once it finishes successfully, you will have
to reboot before the new firmware wil take effect.

2 Click Browse to browse to the location of the upgrade file, and
then double-click the filename. The name of the file appears in the
Enter or select the name of the firmware upgrade file: entry

field.

3 Click Upgrade. The file is imported to the IF30. When the file has
been imported, the Save/Discard Changes screen appears. The new
firmware version appears under Pending Upgrade. You may need
to scroll to see this part of the screen.

Logout | Save/Discard Changes ‘ Upgrade Software ‘

Save/Discard Changes

Havigation Menu

Secure IF30 RFID Reader Configuration

E- B Ethernet

1Pvé Configuration
B RFID Module:
B Metwork Services
Bl B Metwork Management
E- @ Security
B Maintenance

‘ Save Changes and Reboot ‘ | Discard Changes and Reboot |

Save Changes without Reboot

Discard Pending Changes | ‘ Restore Factory Defaults

Possible Configuration Errors

The login password has not been changed from its default value.

Pending Changes

MO CHANGES
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4 To continue the upgrade, click Save Changes and Reboot. The
Rebooting screen appears, the IF30 reboots, and the upgrade
begins. This process can take several minutes. Do not cycle power
to the IF30 during the upgrade. When the upgrade process is
complete, the IF30 reboots.

To cancel the upgrade, click Discard Pending Changes.

Troubleshooting the IF30

This section includes lists of problems and possible solutions.

Problems While Working With RFID

Many problems you may encounter when working with your RFID
system can be solved by carefully checking the RFID settings and
changing them accordingly. For help, see “Configuring RFID
Settings” on page 42.

RFID Problems and Solutions

Problem Solution

The IF30 is unable read RFID Check these conditions:

tags, or seems to read tags slowly o your RFID antennas must be connected correctly

or inconsistently. to the IF30 and mounted in optimum locations.
Make sure all antenna connections are tight and
that the cables are in good condition. For help,
contact your Intermec RFID system consultant.

¢ Terminators must be installed on all unused RFID
antenna ports. If you have operated the IF30
without terminators on all unused antenna ports,
the RFID module may be damaged. For help,
contact Intermec Product Support.

* To maximize IF30 performance, make sure you
have chosen the correct Tag Type for your
application. For help, see “Configuring RFID
Settings” on page 42.

68 IF30 Fixed Reader User’s Manual



Chapter 4 — Managing, Upgrading, and Troubleshooting the IF30

Problems With Network Connectivity

When troubleshooting problems with network connectivity, make
sure you know and understand these network-specific settings:

* TCP/IP settings

* COM port settings for serial connections

You should also make sure all physical network connectors and cables
are in good working order.

Connectivity Problems and Solutions

Problem Solution

You have assigned a static IP Make sure that DHCP is disabled and that your TCP/IP
address to the IF30 but cannot parameters are set correctly. For help, see “Configuring the
connect to the IF30 over your IF30 (Setting the IP Address)” on page 9.

network.

You cannot load a security You must use a secure web browser connection to load

certificate. certificates. For help, see “Using the Web Browser
Interface” on page 14.

You cannot connect the IF30 1 Verify if you are using the correct null modem cable.

using the serial port. 2 Verify that you ar communicating through the correct

serial port.
3 Verify that your PC is set to 9600, N, 8, 1, no flow control.

You cannot connect to the IF30 1 Verify that you are not using a crossover cable if you are
using a web browser. connected to a hub or switch. Verify that you are using a
crossover cable if connected directly to the server or PC.

2 Open a HyperTerminal session to the IF30, and verify that
you did not enable web browser access in the Security
screen.

3 Ifyou access the Internet through a proxy server, be sure
you have added the IP address of the IF30 to the Exceptions
list.
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Calling Intermec Product Support

70

You may need to call Intermec Product Support if you have problems
operating the IF30. Before calling, be sure you can answer the
following questions:

What kind of network are you using?

What were you doing when the error occured?
What error message did you see?

Can you reproduce the problem?

What is your IF30’s serial number?

What version of the IF30 and RFID software are you using? For
help, see “Viewing the About This IF30 RFID Reader Screen”
on page 63.

When you have these answers, call Intermec Product Support at
1-800-755-5505.
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Using the IF30 GPIO Interfaces

This chapter explains how to access the IF30 general purpose
input/output (GPIO) interfaces and how to connect industrial
controls such as motion sensors or indicator lamps to the IF30
Fixed Reader. This chapter includes these topics:

* About the GPIO Interfaces

* Accessing the GPIO Interfaces
* Using the Input Interfaces

* Using the Output Interfaces

* Using the Power Interface
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About the GPIO Interfaces

The IF30 has four general purpose input and output (GPIO)
interfaces. You connect external controls such as motion sensors or
indicator lamps to the GPIO interfaces, which can then trigger IF30
operations.

Each interface is electrically isolated from the IF30 and designed for
low voltage DC loads. The IF30 can also supply 12 VDC at 0.5 A to
external devices.

How the inputs and outputs are used depends on the RFID
application software being used in the system. You need to coordinate
input and output control wiring with the software developer.

Accessing the GPIO Interfaces

72

You can access the GPIO interfaces through the control port on the
front panel of the IF30. The control port uses a standard 25-pin serial
cable. For port pin assignments, see “Port Pin Assignments” on
page 84.

You can also use the GPIO Terminal Block accessory to connect
devices to the IF30 GPIO interfaces. The block provides access to the
IF30 GPIO interfaces via standard screw terminals.

GPIO Terminal Block Accessory

For more information on the terminal block, contact your local
Intermec distributor.
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Using the Input Interfaces

Each of the four inputs is compatible with input signals of 10 to 48
VDC. Both of the high and low signal contacts are exposed and
isolated to 1500 V. Input impedance is 1.8K minimum.

GPIO Signal Input Descriptions

Signal Description Min. Typical Max.
Vi, (High) High inputvoltage 10V 24V 48V
V,, (Low) Low inputvoltage -1V ov v

In a typical application, the IF30 senses input from an external
control like a switch and then starts a tag read operation.

There are three basic ways to connect input controls to the IF30 input
interfaces:

* Supply the input interface with power from the IF30.
* Isolate the IF30 from the input power source.

* Use an open collector solid state drive from a remote device to
control the inputs.

IF30 Powered Input

This is the simplest way to connect a control to an IF30 input
interface. If the external control device is a switch, you can connect
one side of the switch to an IF30 +Input pin, and the other side of the
switch to one of the +12 VDC sources, then ground the corresponding
-Input pin.
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+12V
+Input o o
External
input
switch
-lnput <—

Ground <——
IF30 Powered Input

Isolated Input Interface

This method is used to minimize noise induced by distance or
grounding. The isolated input avoids induced noise by referencing a
remote input to chassis return of the IF30. The illustration below
shows how to wire in this method.

External

input

switch

+Input R A o/o
1 1
1 1
1

-Input ; ! @

[ T —— 1
/ 10-48 VDC
Twisted
pair

Isolated Input Interface

Open Collector Interface

The input can be connected to an open collector interface of an
external device. This implies that the grounds are tied together for
two systems. The common ground can be a source of noise, so you
should follow good grounding practices for both the IF30 and the
input device.

In this situation, the IF30 provides power to the pull-up resistor for
the open collector. Connect the +Input pin to the +12 VDC source as
shown in the next illustration.
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+12V

+Input

-Input
Ground

Open Collector Interface

Using the Output Interfaces

Each IF30 output interface is optically isolated, polarized, and rated
for 5 to 48 VDC at 0.25 A. Al TF30 outputs include internal thermal
fuses that trip if the load exceeds 0.25 A, and the fuses are self-
recovering once the excessive load is removed. The high and low
contacts are exposed and isolated from the ground. Transient
suppression limits output voltage spikes to 65 VDC.

GPIO Output Specifications

Signal Description Min. Typical Max.

Leakage  Switch output, 0 mA 1 mA 10 mA
current high leakage
(High) current

Ve (Low) Switch output 0V 1V 1.5V
on, saturation
voltage with .25A
load

Since the outputs are optically isolated, each of the outputs can be
configured to switch the high or low side of the load. You can power
the load directly from the IF30 or from an external power supply.

In a typical application, the outputs control indicator lamps that
signal good reads or errors. These are the basic methods for
connecting external devices to the GPIO outputs:

* Switching the high side, with the load powered by the IF30.
* Switching the low side, with the load powered by the IF30.
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* Switching the high side, with the load powered externally.
* Driving a DC relay that controls an AC load.

Switching the High Side Using IF30 Power

In this example, an external indicator lamp with a 0.25A maximum
current is connected to the -Output and Ground pins, and the
corresponding +Output pin is connected to the +12 VDC source.

+12V
+0utput
External
indicator lamp
0.25A maximum
-Output L] s
> )—
Ground [ ~
Switching the High Side

Switching the Low Side Using IF30 Power

For low side switching applications, the lamp is routed to all the
lamps in common and the low side of the load is routed to the switch.

In this method, connect the external indicator lamp to the +Output
and +12 VDC pins, and short the corresponding
-Output pin to ground as shown.

External
indicator lamp
0.25 A maximum

2V L s
o )—
+0Output [ ~=
-Output
Ground
Switching the Low Side
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Switching the High Side Using External Power

To use external power (S to 48 VDC) to switch the high side, connect
the Ground pin to the ground system of the external power supply,
and connect the positive side of the external supply to the +Output
pin. The external indicator lamp is connected to the corresponding -
Output and Ground pins as shown below.

)
External
power
5-48 VDC

+Output <—————

-Output

L /
D )—
Ground [ ~_

External
indicator
lamp

Switching the High Side With External Power
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Driving a DC Relay to Control an AC Load

%

While the IF30 outputs are designed to switch DC loads, they can
drive relays that control AC loads. The illustration on the next page
shows how to connect such a system to an IF30 output.

AC motor

+2V <——— :

+Output <—————

-Output 120-230
—_—— - fL VAC
Ground (e} ”

External
relay

77

Driving a DC Relay: The external relay provides dry contacts for controlling the
AC motor.

Note: In many installations, the relay and AC wiring must be placed in
an enclosure that meets local fire code regulations.

Using the Power Interface

78

The IF30 GPIO interface provides 12 VDC at 0.5 A for powering
external inputs and loads, eliminating the need for an external DC
supply and simplifying the system installation.

The GPIO interface power has an internal thermal fuse that trips if
the load exceeds 0. SA. The fuse is self-recovering once excessive load is
removed.

The total load on the GPIO interface power must stay within the 0.5 A
limit. When you design a system that uses the GPIO interface power,
be sure to complete a power budget assessment to ensure that the
supply is adequate for the system.
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If your system needs more than +12 VDC at 0.5 A, you can connect to
an external power supply to the +12 V and Ground pins. The external
supply powers the external loads, and that power will be available at
all +12 V pins on the control port.
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Specifications

This appendix includes physical and electrical specifications
for the IF30 and information about the port pin assignments.
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IF30 Specifications

82

Specifcations
Height
Length
Width
Weight

AC electrical rating

Operating temperature
Storage temperature
Humidity (non-condensing)
Ethernet interfaces

Ethernet compatibility

Ethernet data rate

Serial port maximum data
rate

SNMP agent

Linux version

Values

9.5cm (3.81n)
35.5cm (14.0in)
23.6 cm (9.3 in)
2.63 kg (5.81b)

~~ 100 to 240V, 1.0 to 0.5A, 50 to 60
Hz

-20°C to +55°C (-4°F to +131°F)
30°C to +75°C (-22°F to +167°F)
10 to 90%

10BaseT/100BaseTx (twisted-pair)

Ethernet frame types and Ethernet
addressing

10 Mbps/100 Mbps
115,200 bps

RFC 1213 (MIB-2), RFC 1398 (dot3)
2.6.11.5
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Specifcations

Protocols Supported

Frequency Range
Usable channels

Output power
865-867 MHz, 915 MHz

869 MHz

Occupied frequency
bandwidth

Tag data rate

Dispatch rates

Tag ID rate

Tag data exchange rate

Write range

Transmitter type

Frequency stability

Number of antennas
Antenna port isolation

Antenna connectors
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Vaules

EPCglobal Class 1 Gen 2

ISO 18000-6B Generation 1

ISO 18000-6B Generation 2

Phillips v1.19

865-868 MHz, 869 MHz, or 915 MHz
1

Minimum: 28.5 dBm
Typical: 29.5 dBm
Maximum: 30.0 dBm

Minimum: 25.5 dBm
Typical: 26.5 dBm
Maximum: 27.0 dBm

<250 KHz

32 kbps/160 kbps

70 tags per second

Reads a tag containing 8 bytes of data
within 12 ms. Performs a verified write
to a tag at an average rate of 31 mS per

byte per tag.

Up to 70% of the read distance under
similar conditions

90% amplitude modulation index

<+100 ppm from -25°C to +55°C
(-13°F to 131°F)

Up to 4, electronically switched
22 dB

865-867 MHz: SMA
915 MHz: Reverse SMA
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Port Pin Assignments

Control Port

Pin 14 Pin 25
XOOOOOOOOOO

@ ooooooooooo&@

Pin 1 Pin 13

Control Port Pin Assignments

Pin Description Active Polarity
1 -Input 1 Low-RTN

2 -Input 2 Low-RTN

3 -Input 3 Low-RTN

4 -Input 4 Low-RTN

S Ground

6 Ground

7 +Output 1 High (10-48V)
8 Ground

9 +Output 2 High (10-48V)
10 Ground

11 +Output 3 High (10-48V)
12 Ground

13 +Output 4 High (10-48V)
14 +Input 1 High (10-48V)
15 +Input 2 High (10-48V)
16 +Input 3 High (10-48V)
17 +Input 4 High (10-48V)
18 12VvDC

19 -Output 1 Low-RTN

20 12VvDC

21 -Output 2 Low-RTN

22 12VvDC

23 -Output 3 Low-RTN
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Control Port Pin Assignments (continued)

Pin Description Active Polarity
24 12vDC
25 -Output 4 Low-RTN
Serial Port
Pin 1
0000 o/
) o000 // ©
Pin 9

Serial Port Pin Assignments

Pin Description Active Polarity

1 NC

2 Receive data (RXD)  High

3 Transmit data (TXD) High

4 NC

) Signal ground

6 NC

7 NC

8 NC

9 NC

Ethernet Port
1 Pin 1

LI
Ethernet Port Pin Assignments

Pin Description Pin Description
1 LAN_RX+ S VDC_A

2 LAN_RX- 6 LAN_TX-
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Ethernet Port Pin Assignments (continued)

Pin Description Pin Description
3 LAN_TX+ 7 VDC_B
4 VDC_A 8 VDC_B

& Note: The IF30 does not support power over Ethernet (POE).
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Index

88

A

About This IF30 RFID Reader
screen 63
AC power port
described 5
location 4
access via menus, controlling 31
Allow External EPC Connection
setting 50
Allow Service Password check box
36
Always Use DHCP setting 26
antenna firing sequence, for RFID,
described 48
ANTTRIES equivalent 47
applications
configuring data collection
engine 49
how to develop 42

Basic Reader Interface
attribute equivalents for RFID
module settings 44
blue LED, described 7
Heartbeat setting 50
TCP Port setting, for DCE 50
blue LED, described 7
bracket, mounting, described 18
BRI Heartbeat setting 50
BRI TCP Port setting, for DCE 50
Browser Access setting, described

32
C

cable access door, removing 4
Certificate Details screen,
illustrated 37
configuring the IF30
active configuration file,
described 16
connecting via Ethernet 11
connecting with
communications program
10
current configuration file,
described 16
data collection engine 49
default configuration file,
described 16

default configuration, restoring
66

DHCP settings 26

DNS settings 28

Ethernet link speed 24

Ethernet settings 24

firmware, upgrading 66

Intermec Settings, using S6

IP address 9

network services 28

network settings 24

password server 34

saving changes 17

security 30

setting IP address, described 9

SNTP client settings 30

SYSLOG destination 28

username and password, setting
33

using web browser interface 14

viewing summary 63

control port
location 4
pin assignments 84

data collection engine 50
Allow External BRI Connection
50
BRI TCP Port 50
configuring 49
Enable Logging 50
EPC TCP Port 50
log, enable and viewing 50
logfile command event
descriptions 52
settings, described 50
statistics, viewing 52
trigger, managing 50
using with Intermec Ready-To-
Work indicator 7
Data Privacy Protocol setting, for
SNMPv3 60, 61
date and time
setting with web browser
interface 20
SNTP client settings 30
DCE Configuration screen,
illustrated 49
default configuration, restoring 66
default login, changing 35
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defaults, restoring 66

DHCP Mode setting 26

DHCP settings, configuring 26

Disable DHCP setting 26

Display Log screen, for DCE,
illustrated 50

DNS settings, configuring 28

electrical specifications 82

Enable Antenna Port check box 48

Enable Logging check box, for DCE
50

Enabling Autoconfiguration, for
IPv6 27
EPC TCP Port setting 50
EPCglobal Class 1 Gen 2
certification 2
tags, choosing in RFID Module
Settings 44
Ethernet 26
IF30 in wired network,
illustrated 9
ort
described S
pin assignments 85
settings, configuring with web
browser interface 24
troubleshooting problems 69
Ethernet port
location 4
Events Log screen, illustrated 62
events log, viewing in Maintenance
menu 62
external controls, using with IF30
72

F

Field Separator setting 45
Field Strength setting 48
fields, in tags, separating 45
FIELDSEP equivalent 45
FIELDSTRENGTH equivalent 48
firmware upgrades 66
front panel ports

accessing 4

described 5

G
general purpose input/output
interfaces 72
accessing 72
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described 72

inputs, using 73

isolated input 74

open collector input 74

output, switching the high side
using external power 76

output, switching the low side

power, using 78

powered input 73

relay, driving to control AC load
78

switching the high side using

external power 77

H

HyperTerminal, using to configure
IF30 10

ID Report check box 46
ID Tries setting 46
IDTRIES equivalent 46
1F30
configuration summary, viewing
64
connecting to network 19
connecting with
communications program
10
default configuration, restoring
66
described 2
DHCP state, describe 9
dimensions 82
Ethernet network, described and
illustrated 9
firmware, upgrading 66
installing 18
IP address, setting 9
learning about 4
locating with LEDs 63
maintaining 61
managing 56
mounting location, choosing 18
overview 2
RFID settings, configuring 42
SNMP, managing with 59
specifications 82
troubleshooting 68
unpacking 3
using securely 21
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Index

90

Init Tries setting 47
Initial Queue 48
initialize tags setting 47
INITIALQ equivalent 48
INITTRIES equivalent 47
input interface
isolated 74
open collector 74
powered 73
signal descriptions 73
installing
IF30 18
RFID antennas 19
Intermec
Product Support, what to know
when calling 70
Settings, application 56
SmartSystems Console 56
Internet Protocol version 6
enabling in communications
program 12
enabling in web browser
interface 27
IP address
saving changes 16
setting 9
with communications program
10
with web browser interface 24
IPv6. See Internet Protocol version 6

L

LEDs
described 6
Intermec Ready-to-Work
Indicator 6
location 6
power 6
wired LAN 6
location, choosing for IF30 18
Lock Tries setting 47
LOCKTRIES equivalent 47
login screen 14
login, changing default 35

M

maintaining the IF30 61
Maintenance menu
About this IF30 RFID Reader
screen 63
configuration summary 64
events log, viewing 62

port statistics, viewing 61
using LEDs to locate the IF30 63
managing the IF30
defaults, restoring 66
firmware, upgrading 66
methods 56
SmartSystems Foundation 56
SNMP 59
using securely 21
motion sensors
using with the IF30 72
mounting location, choosing 18

network 19
connecting IF30 to 19
DNS settings, configuring 28
Ethernet connection, in
communications program
11
IF30 illustrated in 9
SNTP client settings,
configuring 30
SYSLOG destination,
configuring 28
No Tag Report check box 46
NOTAGRPT equivalent 46
NOTAGS message, enabling or
disabling 46

0

output interface
driving external DC relay 78
high side switching 76
high side switching with eternal
power 77
low side switching 76
output interfaces 75
signal descriptions 73
overview of the IF30 2

P

Password

user login 36
password settings, described 36
Passwords screen

illustrated 34
pin assignments, for ports 84
pinouts 84
port pin assignments

control 84

Ethernet 85
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serial 85
ports
AC power §
control 5
Ethernet S
front panel, accessing 4
front panel, described 5
pin assignments 84
rear panel, described 8
RFID antenna 8
serial 5
power interface 78
power port, described 5
problems with IF30, solving 68
Product Support, calling Intermec

proxy server, using to access
Internet 14

R

RADIUS authentication server,
described 33

RDTRIES equivalent 47

Read Only Password setting 36

Read Tries setting 47

reader module, settings 42

Ready-to-Workindicator,described
7

rear panel ports, described and
illustrated 8
Reject Expired Certificates check
box 32, 39
RFID
antenna firing sequence,
described 48
antenna port locations 8
applications, how to develop 42
IF30 settings, described 44
module, configuring 42
RFID Module screen, illustrated
43
specifications 83
troubleshooting problems 68

S

Saving Configuration Changes 16
securely using the IF30 21
security

certificates described 37

configuring 30

controlling menu access 31

default login, changing 35
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password server, using with IF30
34
supported methods 30
Select Tries setting 47
SELTRIES equivalent 47
serial port
location 4
pin assignments 85
service password, described 36
SESSION equivalent 48
Session settings 48
Set Clock screen 20
Simple Network Time Protocol
(SNTP) client settings,
configuring 30
SmartSystems Foundation,
Intermec, using to manage
IF30 56
SNMP
Community settings, described

parameters, described 60

using to manage IF30 59
SNMPv3

Authentication Protocol 60, 61

Data Privacy Protocol 61

enabling 59

settings, described 60
specifications

electrical and physical 82

RFID 83
summary of configuration settings

in Maintenance menu 64

summary of settings, viewing 64
support, calling Intermec 70
SYSLOG destination

configuring 28

defined 29
SYSLOG server 29

T
Tag Type setting 44
tags, RFID
choosing type 44
ID reporting, enabling or
disabling 46
TAGTYPE equivalent 44
TCP/IP screen, illustrated 25
TCP/IP settings, configuring 24
terminators, location 8
time and date
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Index

92

setting with web browser
interface 20
SNTP client settings 30
Timeout Configuration mode,
enabling 46
TIMEOUTMODE equivalent 46
trigger, managing with data
collection engine 50
TRIGGERREADY coommand,
from DCE 50
troubleshooting the IF30 68
connectivity problems 69
default configuration, restoring
66
Intermec Product Support,
calling 70
port statistics, viewing 61
RFID problems 68

u

Unpacking the IF30 2
Unselect Tries setting 48
UNSELTRIES equivalent 48
upgrade files, where to find 66
Upgrade Software screen,
illustrated 67
upgrading firmware 67

Use DHCP if IP Address is Zero
setting 26

Use RADIUS for Login
Authorization check box 36

User Name setting, for passwords
36

Using the IF30 Securely 21

w

Wavelink Avalanche
parameters, described 58
using to manage IF30 58
web browser interface 14
data collection engine, changing
settings 49
date and time, setting 20
defaults, restoring 66
enabling or disabling 31
Maintenance menu 61
RFID module, changing settings
42
secure 14, 15
SNMP, enabling 59
upgrading firmware 66
Wavelink Avalanche, enabling
57
Write Tries setting 47
WRTRIES equivalent 47
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